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Requirements and Compatibility
Requirements (page 1)

External Address and Port (page 1)
Event Trigger Notifications (page 1)
Common Language Runtime (CLR) (page 1)

Compatibility (page 2)
Signature (page 2)
Transfer Layer Security (TLS) (page 2)

Requirements

External Address and Port
The external address and port must not be blocked. This is required for Signature Agent communication.

appservice-01.act.key2act.io:58100

Event Trigger Notifications
Event trigger notifications are set up within two applications:

Signature Agent
See Completing Signature Agent Configuration (page 4) for additional information.

For standard communication, Signature Agent contains the event notification setup.
For advanced communication, Signature Agent contains the company information including the logos and 
accent color for the HTML email.

Schedule
In Schedule, see Setting Up Technicians in Schedule (page 22).

For standard communication, Schedule contains the technician's information including the technician/
customer's email address. 
For advanced communication, Schedule contains the technician's information including the technician's 
position, email address, and photo in the HTML email. 

Common Language Runtime (CLR)
NET Framework CLR must be enabled in SQL Server. The Signature Agent uses a CLR assembly that executes with 
permissions set to "SAFE".

To enable this, in SQL Server run this command:



Signature Agent 2024 - Installing Signature Agent Configuration

2

•
•
•

•

•
•
•

1.
2.

3.
4.

5.

6.
7.

EXEC sp_configure 'clr enabled', 1; 

RECONFIGURE WITH OVERRIDE;

Compatibility
Signature Agent 2.5 is compatible with the following.

Signature
Schedule 4.7 or higher
2018 R7 (18.05b07) or higher
2018 R6 (18.04b06)

Transfer Layer Security (TLS)

Server Protocols
TLS 1.2

Client Protocols
TLS 1.0 (currently required)
TLS 1.1
TLS 1.2

Installing Signature Agent Configuration
Right-click Signature Agent 2.x.x.exe and select Run as administrator.
If prompted with the User Account Control window, select Yes to allow the program to make changes to the 
computer.
On the Welcome to the Signature Agent Setup Wizard window, select Next.
On the End-User License Agreement window, review and accept the terms of the license agreement, and then 
select Next.
On the Select Installation Folder window, accept the default installation location C:\Program Files 
(x86)\Signature\Signature Agent or use the Browse button to select a different installation location, and then 
select Next.
On the Ready to Install window, select Install.
On the Completing the Signature Agent Setup Wizard window, select Finish.

If the standard event trigger and Advanced Comm trigger emails are not reflecting the correct time, this can fix 
this by launching Signature. Then go to Microsoft Dynamics GP > Tools > Settings > Service Management > 
Module Setup > Setup Options. In the Setup Options window, click OK.
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Upgrading Signature Agent Configuration

Upgrading Signature Agent
Right-click Signature Agent 2.x.x.exe and select Run as administrator.
If prompted with the User Account Control window, select Yes to allow the program to make changes to the 
computer.
On the Welcome to the Signature Agent Setup Wizard window, select Next.
On the End-User License Agreement window, review and accept the terms of the license agreement, and then 
select Next.
On the Select Installation Folder window, accept the default installation location C:\Program Files 
(x86)\Signature\Signature Agent or use the Browse button to select a different installation location, and then 
select Next.
On the Ready to Install window, select Install.
On the Completing the Signature Agent Setup Wizard window, select Finish.

After Completing the Upgrade Steps
Uninstall the Previous Version of Signature Agent (page 4)
Uninstall/Install Service in Signature Agent (page 4)
Verify Trigger Status (page 4)

This is happening because the appointmentview relies on the K2ACDC.setupoption record to exist in the 
K2ACDC.setupoption table. This table contains the Time Zone View setting so if the record is not there, it 
reverts to TZV=False. By performing the step above of launching the Setup Option window and clicking OK 
creates a record in the table and then the email times will be reflected accurately.

•

•

IMPORTANT

Prior to upgrading
Do not uninstall your previous version of Signature Agent before upgrading as data from the original 
installation is used. The previous version can be uninstalled after upgrading.
Document any additional CDC Configuration triggers that have been enabled as these may be disabled 
after upgrading.

If the standard event trigger and Advanced Comm trigger emails are not reflecting the correct time, this can fix 
this by launching Signature. Then go to Microsoft Dynamics GP > Tools > Settings > Service Management > 
Module Setup > Setup Options. In the Setup Options window, click OK.
This is happening because the appointmentview relies on the K2ACDC.setupoption record to exist in the 
K2ACDC.setupoption table. This table contains the Time Zone View setting so if the record is not there, it 
reverts to TZV=False. By performing the step above of launching the Setup Option window and clicking OK 
creates a record in the table and then the email times will be reflected accurately.
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Uninstall the Previous Version of Signature Agent
When upgrading to Signature Agent 2.x.x from a previous version, you will need to uninstall the previous version using 
Windows Add/Remove Programs.

Uninstall/Install Service in Signature Agent
In Signature Agent, you will need to uninstall and then reinstall the service for each company. 

Launch Signature Agent Configuration.
From the button bar, select Uninstall Service.
Select OK in the Success pop-up window.
Select Install Service.
Select OK in the Success pop-up window.

Verify Trigger Status
In Signature Agent, on the Home tab, expand each company.
Select either Event Triggers or Advanced Comm Triggers to view the triggers.
Verify that the triggers that were enabled prior to upgrading are still enabled.

Completing Signature Agent Configuration

Launch Signature Agent Configuration
This is the user interface that is used to configure the CDC and Event triggers.

Launch Signature Agent Configuration.
On the Login window, enter the following information:

SQL Instance
Authentication
Login
Password

Select Login. 
The Signature Agent Configuration is divided into two tabbed sections:

Home: The Home tab is where Signature Agent is configured.
CDC Configuration: The CDC tab is used to set up the CDC for the database for capturing state changes 
to the database tables.

Set Up Change Data Capture (CDC) Configuration
Create the CDC change options on the CDC Configuration tab.

In Signature Agent Configuration, select the CDC Configuration tab.
In the Name column, expand the Dynamics GP database.
Select the company database.
Select Create Objects to create the CDC change options that are listed on the right side of the window.
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The following entities are available:
Appointment
Equipment
GP Customer
Job
Job Cost Code
Location
Service Call
Service Option
Technician

To enable an entity, select the entity name and then select Start from the menu bar. For example, enable Job to 
track changes to the job tables for job appointments. To disable an entity, select Stop from the menu bar. 

Enabled entities are indicated with a green checkmark icon.
Disabled entities are indicated with a red square icon.

Configure Signature Agent
Each company that will be used with Signature Agent Configuration will need to be set up by associating the company 
to a Signature Agent Service that will be monitored for changes.

On the Home tab, create a new company by choosing New Company or select an existing company.
From the menu bar, select Properties.
In the Edit Company Connection window, complete the following tabs:

Database
Access
Company Info
Advanced Comm - This tab only displays if you have purchased Advanced Communications.
Dispatcher Email
Maintenance

After you select the OK button to save changes made to any of the tabs in the Edit Company Connection window, 
you will need to restart the Service. A pop-up window displays to remind you to complete this step. You can do 
this by selecting the Restart button from the button bar is Signature Agent or in the Properties window by 
selecting the Agent Service drop-down and then select Restart Service.

Database Tab
Enter the company database settings.

Select the Database tab.
Enter the Company Name. This is only used for the display name in the Tenant tree to the left.
Enter the Database Name or select Browse and then select the company database.
Enter the database Username and Password.
Select Test Connection to verify that the database settings are correct and can connect to the database. You will 
be prompted to save the settings prior to the test running. 
The Access Key is generated at this time and can be found on the Access tab.
Select OK.

Select OK on each tab to save changes.
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Access Tab
Enter the Email Alias to create the email address that your customers will use when sending an email to create a service 
call. This email alias is also used as the "Sender" when sending communications to your customers and technicians. For 
example, if you create an alias of Fabrikam, your customers would send an email for a service 
to fabrikam@servicerequests.io. 

Select the Access tab.
Select Show to view the Incoming Access Key and the API Key.

The Incoming Access Key is generated by the database once the company is saved prior to testing the 
configuration. This key is used as a unique identifier. 
The API Key is automatically generated from WennSoft.

Enter the Email Alias. This is the email address that notifications are sent from when sending notifications.
You can select the Agent Service drop-down to perform the following service options. These options are also 
available from the menu bar on the Home tab. Customer Support may direct you to perform these steps during 
troubleshooting. 

Install Service
Uninstall Service
Reinstall Service
Restart Service

Select OK.

Company Info Tab
Select the Company Info tab.
Enter the company information that can be included in some of the communications to your customers.

Company Name
Company URL
Address
City
State
Zip
Phone Number
Email

Select OK.

Advanced Comm Tab
Select the Advanced Comm tab.
Complete the following fields: 

Header Logo: Select Upload and then navigate to the location of your logo and select OK. The maximum 
width for the logo is 185 pixels. 

Select Preview to view the logo. 
Select Delete to remove the logo.

Footer Logo: Select Upload and then navigate to the location of your logo and select OK. The maximum 
width for the logo is 185 pixels. 

Select Preview to view the logo.
Select Delete to remove the logo.

Accent Color: Select the Accent Color drop-down. You can select between Custom, Web, or System tabs 
for choosing or entering the color that will display at the top and bottom of the email.
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Select OK.

Dispatcher Emails Tab
This section is used for selecting which email addresses to receive service call updates. The email addresses displayed 
are set up in the User Roles section of Schedule Administrator Settings. See Working with Roles in the Schedule User 
Guide.

Select the Dispatcher Emails tab.
Mark the email address checkbox(es) to indicate where notifications of service call updates should be sent. 
Select OK.

Maintenance Tab
This section is used for setting up a Maintenance Schedule. The Next Scheduled Eventing Pause is used to stop 
Signature Agent from accessing the database. This allows you to perform database maintenance without 
generating CDC records that might generate communications.

Select the Maintenance tab.
Select Edit.
In the Eventing Schedule Editor window, create an optional schedule to pause the Eventing Engine.

Select Weekly or Monthly.
Weekly - Select the day(s).
Monthly - Select the day number and the frequency.

Select the Time of Day and Frequency.
Enter the Duration (Hours).

Select Preview to view what the next 10 occurrences would be based on the setup. Select OK to return to the 
Eventing Schedule Editor.
Select OK. The Tenant tree now displays the company and automatically creates Event Triggers.

View the Log File
Select View Event Log from the menu bar to view the log.txt file that displays information about trigger events and also 
denotes when issues occur. For example, an email for service was received and a response is sent out.

Optional: Remove JOIN to Table SV000805
Some users have experienced a query timeout with the JOIN to the SV000805 (Note) table. By eliminating this JOIN, 
query performance is significantly improved from taking minutes to run to now only seconds.

If you are not using the Service_Desc_Note field (long note description) when defining standard or advanced 
communication event emails, we recommend that you manually set "ExcludeNotes" to "true" to remove the JOIN.

To remove the JOIN to table SV000805:

Go to C:\Program Files (x86)\Signature\Signature Agent.
Right-click on SignatureAgentService.exe.config and select Edit.
Change the value to "true" for the following line:
<add key="ExcludeNotes" value="false"/>

Save the file.
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Working With Event Trigger Notifications
The event triggers are automatically created for the company after testing the connection and are based on the CDC 
table views. These notifications can be enabled or disabled based on the customer's communication requirements. You 
can send the email notification in Schedule from the appointment window or by right-clicking the appointment and 
then choosing Notify Customer.

There are 9 default standard triggers that are created during the installation:

Appointment-AppointmentCanceled
Appointment-AppointmentCreatedAndScheduled
Appointment-AppointmentReassigned
Appointment-AppointmentRescheduled
Appointment-AppointmentScheduled
Appointment-TechnicianArrived
Appointment-TechnicianCheckedOut
ServiceCall-ServiceCallCreated-2016+ - Email that is sent to your customer if they are using Signature 2016 or 
higher when a service call is created.
ServiceCall-ServiceCallCreatedByEmail-2016+ - Email that your customers are sent after a service call is created 
from an email request from your customer.

Standard event trigger notifications are set up within two applications:

Signature Agent Configuration contains the event notification setup. See Completing Signature Agent 
Configuration (page 4).
Schedule contains the technician information including the technician/customer email address. For more 
information, see Setting Up Technicians in Schedule (page 22).

Only users with Advanced Communications (page 34) can send out HTML emails and use the Notify Customer 
button in Schedule.
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Working With Event Triggers

Editing an Existing Event Trigger
To view the properties on the triggers, select an event trigger and then select Properties or double-click the 
event trigger.
In the Edit Event window, the General tab displays the General Settings and Operations.

Trigger Name: Indicates that any time a service call is created, this event will be active.
Trigger Type: Displays a list of active CDC tables.
Event ID: This display-only value is a concatenation of the "Trigger Type - Trigger Name".
Operations

Mark the operation (Delete, Insert, and/or Update) to occur in the CDC table view when the trigger 
is activated. Depending on the trigger type, additional choices are available in the Operations 
section. 
Select the Watch Columns drop-down to display a multi-select list where you can select the 
columns that need to be watched in the CDC table view. 

The Trigger Enabled checkbox indicates that the trigger is in use.
In the example below, the Appointment-AppointmentCancelled trigger event properties are displayed. This 
trigger is set up to send an email when an appointment status is set to "Cancelled". 

The Operation is set to watch the CDC table for updates to the Appointment_Status column.

Click to view screenshot.



Signature Agent 2024 - Working With Event Trigger Notifications

10

3.

•
•
•

The Trigger Criteria tab is used to set up specific criteria that may need to be met for the trigger to activate. Use 
the Values and Previous Values tabs and the formula buttons to create the trigger criteria. To enter the values 
necessary for the formulas, select the VAL button and enter the data. 

For the example below, continuing to the Trigger tab for the Appointment-AppointmentCancelled trigger event, 
we are looking at the Trigger Criteria. Note that all of the criteria are joined with an AND which indicates that all 
three criteria must be met to activate the trigger. If a criteria is joined with an OR, this indicates that either the 
previous criteria line or the following criteria line must be met.

The Previous Scheduled State (prev_state_scheduled) in the CDC table must be 1.
The Appointment Status must be CANCELLED.
The Appointment Type must be 1.

Click to view screenshot.
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The Actions tab displays the action properties. The initial display is what is currently out-of-the-box setup and 
includes the Name and Action Type. This information is fully editable. Select New (to create a new Action) 
or Edit (to edit an existing Action) to display the Action Properties window.

Action name/Type: View or edit the action that happens when the event is triggered.
Email Recipients: If additional recipients need to receive the email, enter the email address values here. 
The information used for the values that have been set up in Signature.

Caller email address: Stored in the Service Call window [Caller_Email_Address].
Technician email address: Stored in Schedule Resources window [R_Email].

Text Recipients: 
Caller phone: Stored in the Service Call window [Caller_Phone]. 
Technician cell phone: Stored in Schedule Resources window [R_Phone].

Send to Creator: If marked, the creator will also receive email communication when the trigger is 
creating a service call via an incoming email.
Subject: Displays what the subject line will contain.
Body: Displays what the body of the message displays. Different parameters can be selected by right-
clicking and then choosing currently-available values from the current record or you can select 
previously-used values.

In the following example, three emails and two text messages will be sent when the Appointment-
AppointmentCancelled trigger is activated.

One email is sent to the caller's email address, one email is sent to the technician's email address, and 
one email is sent to the creator. One text message is sent to the technician and the other text message is 
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sent to the caller.

Click to view screenshot.

Select Save and then select OK.

Create a New Event Trigger
To create a new trigger on the Home view, select New Trigger Event.
Select the + button to the right of Trigger Type and then enter the name of the view to add.
Complete the remaining fields/tabs as described in Viewing/Editing event trigger properties.

Mappable Fields and Labels
The following is a list of mappable fields/labels for Current Values and Previous Values. 

•
•
•

Attachments can be included and stored
These are not case-sensitive
Spaces are optional
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Current Values

Value Additional Information

Actual_Hours

ADRSCODE Location ID/Number 

Appointment

Appointment_Description

Appointment_Group_ID

Appointment_Priority

Appointment_Status

Appointment_Type

Caller_Email_Address

Caller_Name

Caller_Phone

Cancelled_Reason

Completion_Date

Cost_Code_Alias

CREATDDT Created Date

CRUSRID Created User ID

CUSTNAME Customer Name

CUSTNMBR Customer ID/Number
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Value Additional Information

Description

DEX_ROW_ID

Divisions

EndDateTime Ending Date/Time

ENDTIME End Time

Estimate_Hours

Labor_Override

Location_ADDRESS1

Location_CITY

Location_Contact_Person_1

Location_Phone_1

Location_STATE

Location_ZIP

LOCATNNM Location Name

MDFUSRID Modified User ID

MODIFDT Modified Date

Modified_Time

Priority_of_Call

Problem_Description
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Value Additional Information

Purchase_Order

R_Email Reply To/Caller Email Address - R_Email comes from the 
K2A_ResourceExtension table and is the primary email 
address setup in Schedule.

Service_Call_ID

Service_Desc_Note Service Call Description Note

Service_Description

Service_User_Defined _10

Service_User_Defined _11

Service_User_Defined _12

Service_User_Defined _18

Service_User_Defined _19

Service_User_Defined _2

Service_User_Defined _20

Service_User_Defined _21

Service_User_Defined _3

Service_User_Defined _4

Service_User_Defined _5

Service_User_Defined _6

Service_User_Defined _7
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Value Additional Information

Service_User_Defined _8

Service_User_Defined _9

Service_User_Defined_1

Skill_Level

StartDate Start Date

StartDateTime Start Date/Time

State_Created

State_Scheduled

STRTTIME Start Time

SV_Tool_ID

Task_Date

Technician

Technician_Long_Name

Technician_Status

TechnicianEmail TechnicianEmail comes from the SV00115.SV_Pager_PIN 
column which can be used for the technician's SMS 
email gateway email address. e.g. {phone-number}
@vtext.com1 for Verizon as an example.

TechnicianPhone

TechnicianSkillLevel

http://vtext.com
http://vtext.com
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Value Additional Information

Time_Entered_CB Time Entered checkbox

Type_of_Call Call Type

Type_of_Problem Problem Type

UDCB1 AC Notify flag

UDCB2

UPRTRXCD Payroll Transaction Code

UserDD1

UserDD2

USERDEF1

USERDEF2

USRDAT01

USRDAT02

Wennsoft_Affiliate

Wennsoft_Branch

Wennsoft_Region

WS_Cost_Code Cost Code

WS_Job_Number Job Number
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Previous Values

Value Additional Information

prev_Actual_Hours

prev_ADRSCODE Previous Location ID/Number 

prev_Appointment

prev_Appointment_Description

prev_Appointment_Group_ID

prev_Appointment_Priority

prev_Appointment_Status

prev_Appointment_Type

prev_Caller_Email_Address

prev_Caller_Name

prev_Caller_Phone

prev_Cancelled_Reason

prev_Completion_Date

prev_Cost_Code_Alias

prev_ prev_CREATDDT Previous Created Date

prev_CRUSRID Previous Created User ID

prev_CUSTNAME Previous Customer Name

prev_CUSTNMBR Previous Customer ID/Number
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Value Additional Information

prev_Description

prev_DEX_ROW_ID

prev_Divisions

prev_EndDateTime Previous Ending Date/Time

prev_ENDTIME Previous End Time

Estimate_Hours

prev_Labor_Override

prev_Location_ADDRESS1

prev_Location_CITY

prev_Location_Contact_Person_1

prev_Location_Phone_1

prev_Location_STATE

prev_Location_ZIP

prev_LOCATNNM Previous Location Name

prev_MDFUSRID Previous Modified User ID

prev_MODIFDT Previous Modified Date

prev_Modified_Time

prev_Priority_of_Call

prev_Problem_Description
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Value Additional Information

prev_Purchase_Order

prev_R_Email Previous Reply To/Caller Email Address - R_Email comes 
from the K2A_ResourceExtension table and is the 
primary email address setup in Schedule.

prev_Service_Call_ID

prev_Service_Desc_Note Previous Service Call Description Note

prev_Service_Description

prev_Service_User_Defined _10

prev_Service_User_Defined _11

prev_Service_User_Defined _12

prev_Service_User_Defined _18

prev_Service_User_Defined _19

prev_Service_User_Defined _2

prev_Service_User_Defined _20

prev_Service_User_Defined _21

prev_Service_User_Defined _3

prev_Service_User_Defined _4

prev_Service_User_Defined _5

prev_Service_User_Defined _6

prev_Service_User_Defined _7
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Value Additional Information

prev_Service_User_Defined _8

prev_Service_User_Defined _9

prev_Service_User_Defined_1

prev_Skill_Level

prev_StartDateTime Previous Start Date/Time

prev_State_Created

prev_State_Scheduled

prev_STRTTIME Previous Start Time

prev_SV_Tool_ID

prev_Task_Date

prev_Technician

prev_Technician_Long_Name

prev_Technician_Status

prev_TechnicianEmail TechnicianEmail comes from the SV00115.SV_Pager_PIN 
column which can be used for the technician's SMS 
email gateway email address. e.g. {phone-number}
@vtext.com2 for Verizon as an example.

prev_TechnicianPhone

prev_TechnicianSkillLevel

prev_Time_Entered_CB Previous Time Entered checkbox

http://vtext.com
http://vtext.com
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Value Additional Information

prev_Type_of_Call Previous Call Type

prev_Type_of_Problem Previous Problem Type

prev_UDCB1 Previous AC Notify flag

prev_UDCB2

prev_UPRTRXCD Previous Payroll Transaction Code

prev_UserDD1

prev_UserDD2

prev_USERDEF1

prev_USERDEF2

prev_USRDAT01

prev_USRDAT02

prev_Wennsoft_Affiliate

prev_Wennsoft_Branch

prev_Wennsoft_Region

prev_WS_Cost_Code Previous Cost Code

prev_WS_Job_Number Previous Job Number

Setting Up Technicians in Schedule
In Schedule, select the Menu icon and then select Administration.
Select Resource Options.
Select the resource in the Resource list.
Enter the following information to integrate with Signature Agent Configuration:

Technician Name (required): The technician name defaults into this field.
Position Description: The resource position defaults into this field.



Signature Agent 2024 - Working With Event Trigger Notifications

3 mailto:number@txt.att.net
4 mailto:number@tmomail.net
5 mailto:number@email.uscc.net
6 mailto:number@vtext.com
7 mailto:number@vmobl.com

23

•
•

•
•
•

5.

1.
2.
3.
4.

5.
6.
7.
8.
9.

Phone: Enter the resource's telephone number.
Email address: Enter the company email address(es) that the resource uses. For multiple email 
addresses, separate with a comma. You can also set up an email-to-SMS text message following the 
criteria listed in the table below.
Notifications: Mark if the resource should receive notifications at the email address(es) provided.
Inactive: Mark if the resource is currently inactive.
Select resource image: This image will display in the email that is sent to customers if you are 
using Advanced Communications (page 34).

Select Save.

Email to SMS
Use the information below to set up an email-to-SMS text message by entering the technician's cell number and the 
corresponding carrier email.

Carrier Email to SMS

AT&T number@txt.att.net3

T-Mobile number@tmomail.net4

US Cellular number@email.uscc.net5

Verizon number@vtext.com6

Virgin Mobile number@vmobl.com7

Modifying the Event Trigger Action Properties
Launch Signature Agent Configuration.
Select the Home tab.
Navigate to the company's Event Triggers.
Modify the Event Trigger Action Properties for the email action adding the new location properties 
(Location_ADDRESS1, Location_CITY, Location_STATE, Location_ZIP).
Double-click on the Appointment-{appointment-event-name} event trigger.
Select the Actions tab.
Select the Email action and then select Edit.
Right-click in the Subject and/or Email Body fields to select the new location properties to add.
Select Save.

mailto:number@txt.att.net
mailto:number@tmomail.net
mailto:number@email.uscc.net
mailto:number@vtext.com
mailto:number@vmobl.com
mailto:number@txt.att.net
mailto:number@tmomail.net
mailto:number@email.uscc.net
mailto:number@vtext.com
mailto:number@vmobl.com
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Enabling Additional Triggers in Microsoft SQL Server Management 
Studio

Enabling a Trigger in Microsoft SQL Server Management Studio (page 24)
Enabled Triggers Script (page 24)
Disabled Triggers Script (page 26)

Enabling a Trigger in Microsoft SQL Server Management Studio
By enabling triggers that track changes are turned on or off for these tables. Most of these tables have a delete trigger 
with a name in the format of  ‘XXXX_D_CDC’ where XXXX is the table name and an insert/update trigger in the form of 
‘XXXX_IU_CDC’. Two tables make an exception to this rule and have 3 triggers, one for Insert, one for update and one for 
delete. They are tables SV00300 and SV00301.

To enable a trigger in Microsoft SQL Server Management Studio:

Launch Microsoft SQL Server Management Studio.
Expand Databases > your company database > Tables.
Expand the appropriate table.
Expand Triggers.
Right-click on the XXXX_D_CDC trigger and select Enable. (This is the "delete" trigger.)
Right-click on the XXXX_IU_CDC trigger and select Enable. (This is the "insert/update" trigger.)

Enabled Triggers Script
This script provides a list of all enabled scripts for a given company:

SELECT sysobjects.name AS trigger_name, OBJECT_NAME(parent_obj) AS table_name,

             OBJECTPROPERTY(id, 'ExecIsTriggerDisabled') AS [disabled]

FROM sysobjects

WHERE sysobjects.type = 'TR' AND sysobjects.name LIKE '%_CDC'

       and OBJECTPROPERTY(id, 'ExecIsTriggerDisabled') = 0

ORDER BY disabled,sysobjects.name ASC

Enabled Triggers Query Results
These are the results of the enabled triggers script query, assuming all nine triggers are enabled. Note that the Entity 
name does not display in the query results.
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Entity Table Name Trigger Name Disabled

Job JC00102 JC00102_D_CDC 0

JC00102_IU_CDC 0

Job Cost Code JC00701 JC00701_D_CDC 0

JC00701_IU_CDC 0

GP Customer RM00101 RM00101_D_CDC 0

RM00101_IU_CDC 0

Technician SV00115 SV00115_D_CDC 0

SV00115_IU_CDC 0

Service Option sv00196 sv00196_D_CDC 0

sv00196_IU_CDC 0

Location SV00200 SV00200_D_CDC 0

SV00200_IU_CDC 0

Service Call SV00300 SV00300_D_CDC 0

SV00300_I_CDC 0

SV00300_U_CDC 0

Appointment SV00301 SV00301_D_CDC 0

SV00301_I_CDC 0

SV00301_U_CDC 0

Equipment SV00400 SV00400_D_CDC 0
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Entity Table Name Trigger Name Disabled

SV00400_IU_CDC 0

Disabled Triggers Script
If you need to enable triggers for a table not found in this list, run the following script to find the triggers for a given 
table not in the list and then go through Microsoft SQL Server Management Studio and manually enable the trigger:

SELECT sysobjects.name AS trigger_name, OBJECT_NAME(parent_obj) AS table_name,

             OBJECTPROPERTY(id, 'ExecIsTriggerDisabled') AS [disabled]

FROM sysobjects

WHERE sysobjects.type = 'TR' AND (sysobjects.name LIKE '%_D_CDC' or 

sysobjects.name LIKE '%_IU_CDC')

       and OBJECTPROPERTY(id, 'ExecIsTriggerDisabled') = 1

ORDER BY disabled,sysobjects.name ASC

Disabled Triggers Query Results

GP Database Level

These are the query results at the GP database level from the disabled triggers script.  Note that the Entity name does 
not display in the query results.

Entity Table Name Trigger Name Disabled

Call Source SVCALSRC SVCALLSRC_D_CDC 1

SVCALLSRC_IU_CDC 1

GP Company SY01500 SY01500_D_CDC 1

SY01500_IU_CDC 1
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Company Database Level

Entity Table Name Trigger Name Disabled

GP GL Account GL00100 GL00100_D_CDC 1

GL00100_IU_CDC 1

Job User Defined JC00107 JC00107_D_CDC 1

JC00107_IU_CDC 1

Estimate Revision JC00201 JC00201_D_CDC 1

JC00201_IU_CDC 1

Forecast Revision JC00401 JC00401_D_CDC 1

JC00401_IU_CDC 1

Job Cost Note JC00501 JC00501_D_CDC 1

JC00501_IU_CDC 1

Job Bill Code JC00601 JC00601_D_CDC 1

JC00601_IU_CDC 1

Job Revenue Code JC00610 JC00610_D_CDC 1

JC00610_IU_CDC 1

Employee Union Code 
Master

JC00801 JC00801_D_CDC 1

JC00801_IU_CDC 1

Change Order JC01001 JC01001_D_CDC 1

JC01001_IU_CDC 1
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Entity Table Name Trigger Name Disabled

Change Order Cost Code JC01002 JC01002_D_CDC 1

JC01002_IU_CDC 1

Job Change Order 
Revenue Code

JC01004 JC01004_D_CDC 1

JC01004_IU_CDC 1

Job Vendor JC01501 JC01501_D_CDC 1

JC01501_IU_CDC 1

Job Vendor Date JC01504 JC01504_D_CDC 1

JC01504_IU_CDC 1

Job Project JC01701 JC01701_D_CDC 1

JC01701_IU_CDC 1

Rate Class JC01801 JC01801_D_CDC 1

JC01801_IU_CDC 1

Job Lien Waiver JC20705 JC20705_D_CDC 1

JC20705_IU_CDC 1

Fed Class JC40106 JC40106_D_CDC 1

JC40106_IU_CDC 1

Union Code JC40201 JC40201_D_CDC 1

JC40201_IU_CDC 1

Cost Element JC40209 JC40209_IU_CDC 1
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Entity Table Name Trigger Name Disabled

Resource Extension K2A_ResourceExtension K2A_ResourceExtension_D_CDC 1

K2A_ResourceExtension_IU_CD
C

1

GP Purchase Order POP10100 POP10100_D_CDC 1

POP10100_IU_CDC 1

GP Purchase Order Detail POP10110 POP10110_D_CDC 1

POP10110_IU_CDC 1

GP Address RM00102 RM00102_D_CDC 1

RM00102_IU_CDC 1

GP Salesperson RM00301 RM00301_D_CDC 1

RM00301_IU_CDC 1

Installation By SV_00415 SV_00415_D_CDC 1

SV_00415_IU_CDC 1

Time Zone SV00045 SV00045_D_CDC 1

SV00045_IU_CDC 1

Division SV00077 SV00077_D_CDC 1

SV00077_IU_CDC 1

Note SV000805 SV000805_D_CDC 1

SV000805_IU_CDC 1

Customer SV00100 SV00100_D_CDC 1
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Entity Table Name Trigger Name Disabled

SV00100_IU_CDC 1

Technician Vehicle SV00113 SV00113_D_CDC 1

SV00113_IU_CDC 1

Technician Branch SV00114 SV00114_D_CDC 1

SV00114_IU_CDC 1

Technician Skill Set SV00155 SV00155_D_CDC 1

SV00155_IU_CDC 1

Sublocation SV00201 SV00201_D_CDC 1

SV00201_IU_CDC 1

Problem Type SV00310 SV00310_D_CDC 1

SV00310_IU_CDC 1

Call Type SV00320 SV00320_D_CDC 1

SV00320_IU_CDC 1

Appointment Status SV00325 SV00325_D_CDC 1

SV00325_IU_CDC 1

Technician Activity sv00326 sv00326_D_CDC 1

sv00326_IU_CDC 1

User Define 1 SV00330 SV00330_D_CDC 1

SV00330_IU_CDC 1
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Entity Table Name Trigger Name Disabled

User Define 2 SV00331 SV00331_D_CDC 1

SV00331_IU_CDC 1

Contract Equipment SV00403 SV00403_D_CDC 1

SV00403_IU_CDC 1

Equipment Type SV00405 SV00405_D_CDC 1

SV00405_IU_CDC 1

Manufacturer SV00410 SV00410_D_CDC 1

SV00410_IU_CDC 1

Model Number SV00411 SV00411_D_CDC 1

SV00411_IU_CDC 1

Extended Warranty Type SV00420 SV00420_D_CDC 1

SV00420_IU_CDC 1

Meter Reading SV00430 sv00430_D_CDC 1

sv00430_IU_CDC 1

Contract SV00500 SV00500_D_CDC 1

SV00500_IU_CDC 1

Task Code SV00560 SV00560_D_CDC 1

SV00560_IU_CDC 1

Skill Level SV00572 SV00572_D_CDC 1
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Entity Table Name Trigger Name Disabled

SV00572_IU_CDC 1

Invoice History SV00701 SV00701_D_CDC 1

SV00701_IU_CDC 1

Service Cost Code SV00735 SV00735_IU_CDC 1

Building SV01200 SV01200_D_CDC 1

SV01200_IU_CDC 1

Refrigerant Type SV40180 SV40180_D_CDC 1

SV40180_IU_CDC 1

Refrigerant Code SV40182 SV40182_D_CDC 1

SV40182_IU_CDC 1

Refrigerant Leak SV40184 SV40184_D_CDC 1

SV40184_IU_CDC 1

GP Internet Address SY01200 SY01200_D_CDC 1

SY01200_IU_CDC 1

GP Employee UPR00100 UPR00100_D_CDC 1

UPR00100_IU_CDC 1

GP Employee Tax Info UPR00300 UPR00300_D_CDC 1

UPR00300_IU_CDC 1

GP Employee Pay Code UPR00400 UPR00400_D_CDC 1
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Entity Table Name Trigger Name Disabled

UPR00400_IU_CDC 1

GP Employee State Tax UPR00700 UPR00700_D_CDC 1

UPR00700_IU_CDC 1

GP Department UPR40300 UPR40300_D_CDC 1

UPR40300_IU_CDC 1

GP Position UPR40301 UPR40301_D_CDC 1

UPR40301_IU_CDC 1

GP Pay Code UPR40600 UPR40600_D_CDC 1

UPR40600_IU_CDC 1

GP Workers Comp UPR40700 UPR40700_D_CDC 1

UPR40700_IU_CDC 1

GP Payroll State UPR41100 UPR41100_D_CDC 1

UPR41100_IU_CDC 1

Purchase Order Detail WS10101 WS10101_D_CDC 1

WS10101_IU_CDC 1

TimeTrack Option WS40000 WS40000_D_CDC 1

WS40000_IU_CDC 1

TimeTrack Registered 
User

WS41001 WS41001_D_CDC 1

WS41001_IU_CDC 1
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Entity Table Name Trigger Name Disabled

Attachment WSDOCS WSDOCS_D_CDC 1

WSDOCS_IU_CDC 1

Restoring Default Triggers
You can restore a company's default standard triggers from the Home view.

To restore the default standard triggers:

Launch Signature Agent Configuration.
Select the Home tab.
Expand Tenant and select the company name.
From the top navigation, select Restore Default Triggers.
You may receive up to two confirmation windows, one for standard triggers and one for advanced 
communications triggers. In each confirmation window, select OK.

Working With Advanced Communications
Advanced Communications is an add-on product that provides you with the ability to send the following appointment 
trigger emails to your customers from within Schedule. You can send the advanced HTML email notification in Schedule 
from the appointment window by selecting Notify Customer or by right-clicking the appointment and then 
choosing Notify Customer.

In addition to the default standard triggers (page 0), Advanced Communications provides you the ability to notify the 
customer and/or technician when the following appointment triggers occur:  

Trigger AC_Notify Default Notification

Appointment Canceled 1 Notify Button

Appointment Changed 1 Notify Button

Appointment Completed 0 Automatic

WARNING

This removes ALL the company's trigger configurations and any new triggers you may have created. This 
includes all standard and advanced communication triggers.

If the Advanced Comm Triggers tab is not displayed, contact WennSoft Support.
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Trigger AC_Notify Default Notification

Appointment Scheduled 1 Notify Button

Request Received 0 Automatic

Technician Arrived 0 Automatic

Technician In Route 0 Automatic

Advanced Communications is set up within two applications:

Signature Agent Configuration contains the company information including the logos and accent color for the 
HTML email. For setup information, see Completing Signature Agent Configuration (page 4).
Schedule contains the technician information including the technician's position, email address, and photo that 
is included in the HTML email. For more information, see Setting Up Technicians in Schedule (page 22).

Viewing and Editing Advanced Comm Triggers

Viewing a Trigger's Properties
To view the properties for a trigger, select the trigger and the operations and trigger criteria display at the bottom of the 
window.

Enabling a Trigger
To edit the trigger properties, select an event trigger and then select Properties.
In the Edit Event window, the General tab displays the General Settings and Operations. For Advanced 
Communication triggers, these fields are display-only and cannot be edited, except for the Trigger Enabled 
checkbox.

Trigger Name: Indicates that any time a service call is created, this event will be active.
Trigger Type: Displays a list of active CDC tables.
Event ID: Displays the name of the Event ID.

Because the templates for Advanced Communications are prepopulated and cannot be edited, the Actions tab 
is not enabled in the Edit Event window. To see samples of the email templates, see Sample Advanced 
Communication Email Notifications (page 37).
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Operations: Indicates that any time something deleted, inserted, and/or updated in the CDC table view, 
the trigger will activate. Depending on the trigger type, additional choices are available in the Operations 
section.
The Trigger Enabled checkbox indicates that the trigger is in use.

Select OK.

Editing Trigger Criteria
The Trigger Criteria tab is used to set up specific criteria that may need to be met for the trigger to activate. 

To edit the trigger properties:

Select an event trigger and then select Properties.
Select the Trigger Criteria tab.
Use the Values and Previous Values tabs and the formula buttons to create the trigger criteria. To enter the 
values necessary for the formulas, select the VAL button and enter the data.
If you want to have your triggers automatically send notifications to your customers and technicians, you can 
edit the AC_Notify criteria value to 0. When the AC_Notify criteria is set to 1, the Notify button in Schedule needs 
to be selected to send the notification. 

Click to view screenshot.

Select OK.

When using a DATE field, the parameters must be encompassed between hash marks #.
For example: [CREATDDT] > #2022-01-26 00:00:00#.
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Sample Advanced Communication Email Notifications
The following are examples of the Advanced Communication email templates:

Appointment Cancelled
Appointment Changed
Appointment Complete
Appointment Scheduled
Request Received
Technician In Route
Technician Arrived

Click to view screenshots.
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Sending Email Requests To Create a Service Call
Your customer can send an email that is sent to the accesskey@s8ervicerequests.io email address OR to an email address 
that our user has set up (service@company.com) that forwards the email to the access key email address. 

In Outlook the body text can be added to a Quick Part template gallery to quickly insert the information into a new 
email. The customer would then only have to enter a subject line and the description after inserting the Quick Part. See 
Working with Quick Part Templates (page 52) below.

Your customer opens their email program and opens a new message.
The customer enters the:

Email Address
Email Subject
Email body that follows the template as determined by the user in the Event Trigger Properties.

The following lines including the colon ":" in the body of the email are required to generate a service email. 
Additional fields may be added, like "Equipment ID:".

Customer Number: <Actual customer number in Signature>
Location Number: <Actual location ID in Signature>
Description: <Used in service call description>

Example Email
Example of an email with the optional line for Equipment ID:

http://servicerequests.io
http://servicerequests.io
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Working With Microsoft Outlook Quick Part Templates

Adding a Quick Part Template in Microsoft Outlook
If you are using Microsoft Outlook email, you can have your customers create a Quick Part.

Open a new message window (as if to send a new email).
Type and then select the text to be added as a Quick Part.
On the Insert tab, locate the Text section. (The Insert tab is only visible in a new email. The Text section is only 
enabled if you click in the body of the new email.)

Select Quick Parts.
Select Save Selection to Quick Part Gallery…
In the Create New Building Block window, you can name the Quick Part and enter a description.

Name: Enter a descriptive name.
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Description: Enter a brief description.

Select OK.

Using a Quick Part Template
Open a new message window (as if to send a new email).
On the Insert tab, locate the Text section.
Select Quick Parts.
Select the appropriate template.
The body of the email is populated with the text.
Edit the text as needed.
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Flow Examples
Simple Email (page 54)
Email With Attachment (page 55)
Customer Calls for Service and Wants Notifications (page 58)

Simple Email
Depending on the recipient configuration in the Event Trigger Properties, the following may occur:
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Email With Attachment
In addition to the email, the customer may attach a file to the email message. For example, a picture of the 
malfunctioning equipment.
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Customer Calls for Service and Wants Notifications



Signature Agent 2024 - Flow Examples

59

 



Signature Agent 2024 - Flow Examples

60



Signature Agent 2024 - Accessing the Signature Status Page

61

•
•
•

1.
2.
3.

1.
2.
3.

Accessing the Signature Status Page
The Signature Status page includes the following Signature Agent Application Service status information.

A graph displays the uptime status for the past 90 days. The uptime percentage is displayed beneath the graph.
A calendar view of the uptime by selecting View historical uptime.
Previous incidents are listed by date below the status graph section.

Access the Signature Status Page
In Signature Agent, select About.
Select Signature Status to open a browser to https://signature.statuspage.io/.
Select the Subscribe to Updates button to receive notifications whenever the Status Page has new, updated, or 
resolved incidents. After you subscribed, you'll receive a notification that asks you to confirm your subscription. 
You can receive updates in one or more of the following methods: email, text message, webhook, and/or RSS 
feed. You can also access the WennSoft Customer Support Center.

Uninstalling Signature Agent Configuration

Uninstall the Agent Service
Prior to uninstalling Signature Agent, you will need to uninstall the Agent Service.

Launch Signature Agent Configuration.
From the button bar, select Uninstall Service.
Select OK in the Success pop-up window.

Uninstall Signature Agent Configuration
To permanently remove Signature Agent Configuration, you will need to uninstall Signature Agent from the Microsoft 
Add/Remove Programs window.

https://signature.statuspage.io/
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Contact Information
Support

Phone: 262-317-3800
Email: support@wennsoft.com9 
Hours: Normal support hours are 7:00 a.m. to 6:00 p.m. Central Time. After-hours and weekend support is available for 
an additional charge. Please contact WennSoft Support for additional information. 

WennSoft will be closed in observance of the following holidays: New Year's Day, Memorial Day, Juneteenth, 
Independence Day, Labor Day, Veteran's Day, Thanksgiving Day, the day after Thanksgiving, Christmas Day, and the day 
after Christmas.

Support Plans

We're committed to providing the service you need to solve your problems and help your team maximize productivity.

We offer several Signature Enhancement and Support Plans to meet your needs and Extended Support Plans for retired 
product versions available at https://www.wennsoft.com/wsportal10.

Sales

Phone: 262-317-3700  
Fax: 262-317-3701

WennSoft Headquarters

Address: 
WennSoft
1970 S. Calhoun Rd.
New Berlin, WI 53151-1187 

Phone: 262-821-4100 or 866-539-2228
Email: info@wennsoft.com11

Website: www.wennsoft.com12 
Office hours: Monday through Friday from 8 a.m. to 5 p.m. Central Time.

mailto:support@wennsoft.com
https://www.wennsoft.com/wsportal/
mailto:info@wennsoft.com
http://www.wennsoft.com
mailto:support@wennsoft.com
https://www.wennsoft.com/wsportal/
mailto:info@wennsoft.com
http://www.wennsoft.com
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